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Designing White Guideline

How to Design & Print Labels Using 
Spot Colour White on the             
OKI Pro1050 Label Printer
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Understanding White
The OKI Pro1050’s ability to print white toner on a broad range of coloured media has opened the door for creative 
professionals like yourself to explore the possibilities it offers. Labels printed on clear, coloured and metallic effect media, 
your designs will never look the same once you’ve experienced the power of white.

Whether printing standalone white elements or using white behind colour as a means to preserve its hue on dark media, 
the 5-Station Digital Label Printer is capable of creating extremely precise, controlled output.

This guide will take you through the process of designing and preparing labels that take full advantage of the Pro1050’s 
ability to create unique and impressive and finished pieces.

Why White?
The importance of white in colour printing is often 
overlooked. The foundation of colour printing is based on 
applying Cyan, Magenta, Yellow and Black (CMYK) onto 
white paper. The paper’s white surface reflects a wide 
range of colour back to your eyes.

However, as you can see in the sample above, applying 
colour toner directly onto coloured media creates 
extremely dark, dull results because only a narrow range 
of coloured light is reflected back to your eyes.

When white is laid down underneath colour, it provides 
a protective, reflective surface similar to white paper. The 
result is brilliant colour when printing on coloured media.

And beyond laying down 100% white to preserve hues 
on coloured media or to create standalone white 
elements, the OKI Pro1050 is able to control the amount 
of white toner laid down on different areas of the printed 
page, enabling for advanced techniques which will be 
explored later in this guide.

Driver Setting
You can print through your computer’s Driver, controlling settings from the dialogue box that appears when you select Print 
from your application’s main menu. 

To get the best results from your printing efforts, it’s important to understand a few of the Pro1050’s settings. While the 
Pro1050 User Guide covers the product’s full settings more comprehensively, the overview below focuses on the critical 
areas you’ll be working when using spot colour white on coloured media.
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Spot colour Usage Methods
The way in which you set up your file and the Spot Colour 
Usage Methods setting (from here on referred to as the Spot 
Colour setting) are interdependent. Because of this, it’s ideal 
to first identify the type of file you’ll be printing by how 
white will be used to print that label.

The most common Spot colour settings you’ll be using 
are “Prints Only Spot colour Toner”, “Data Portion - 
Including White” and “Application Specification”. 
The setting chosen is based on how the file is prepared and 
the next section of this guide will cover these options in 
greater detail.
It’s helpful to understand how each setting differs before 
using them.
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Data Portion - Excluding WhitePrinting Only Spot Colour Toner

Driver Setting:
Data Portion - Excluding White.

Label Style:
Combination of black/colour – white toner is applied 
under-neath colour elements.

How This Setting Prints:
Prints 100% white behind all elements (except true black 
el-ements), allowing printed colors to remain vibrant on dark 
or coloured media.

Actual white elements in the original label do not 
receive white toner (for example, a .jpg logo with a white 
back-ground will only print the colour portion of the logo).

Does not print isolated white elements – white is only used 
behind colour.

Note: Because this setting is primarily used to avoid printing 
white backgrounds in logos and other images, it isn’t com-
monly used by creative professionals, so it won’t be covered 
in the lessons.

Driver Setting:
Prints Only Spot colour 
Toner.
Label Style:
Only white toner is printed (no black/colour) – white 
percentages or gradients are allowed.

How This Setting Prints:
Black or colour elements in the original label are printed 
using white toner. The darker the element in the 
original label, the more opaque the white will print. This 
setting causes the Pro1050 to behave like a mono printer 
except white toner is used instead of black.
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Application SpecificationData Portion - Including White

Driver Setting:
Application Specification.

Label Style:
Any combination of black/colour and white in any 
percentag-es (white is defined as “SpotColor_White”).

How This Setting Prints:
White only goes where it has been defined in the original 
label, using the spot colour name for OKI’s white toner 
(SpotColor_White).

Subtle white effects (glows, gradients, percentages) are able 
to be achieved with no restrictions.

This setting allows colour elements to have any amount 
of white behind them or none at all, which isn’t possible 
with any other Spot colour driver setting.

Driver Setting:
Data Portion - Including White.

Label Style:
Combination of black/colour and white (but no subtle 
white).
How This Setting Prints:
Prints 100% white behind all elements (except true black 
elements), allowing printed colors to remain vibrant on 
dark or coloured media.

Also prints elements that are defined as the colour white in 
the original label.

However, percentages of white below 100% are not possible.
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Trapping
Trapping is used to prevent white edges from showing under 
coloured elements, and it has two components: The 
Spread of CMYK elements over White can be set to Off, 
Narrow, or Wide. Choke White Chokes or contracts the 
White elements, and it can be set to On or Off. A more 
detailed overview is included in the Trapping section of 
this guide.
Trapping is a feature that helps to hide unintended white 
edges that sometimes appear around colour objects 
being printed on a page. Trapping helps to resolve 
imperfect registration.

The concept of trapping dates back to old ink presses 
that needed methods to hide imperfect registration of two 
different coloured objects printed next to each other. 
For example, a text headline printed inside a colour box.

There are two approaches to trapping: Spread and Choke.
Spread slightly expands CMYK elements over white, while 
Choke shrinks or contracts the white areas underneath in an 
attempt to hide their edges.

Because the Pro1050 is able to apply white toner behind 
coloured elements to improve their visibility on dark 
paper, Trapping helps to ensure that the white toner 
doesn’t peek out from under the edges of those coloured 
elements.

TRAPPING OFF

NARROW

CHOKE WHITE

WIDE

NARROW/CHOKE WHITE

WIDE/CHOKE WHITE

The OKI trapping feature offers different combinations of Choke and Spread:

Off  - Print without any trapping features
Narrow - Slightly spread colour objects
Narrow/Choke White  - Slightly spread colour objects AND contract areas of white toner
Wide  - Expand colour objects more
Wide/Choke White 
Choke White  

- Expand colour objects AND contract areas of white 
toner - Contract areas of white toner
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You can use this chart for reference:

Trapping Setting Features Spread Choke Example

Off Print without any trap-
ping features

~ ~

Narrow Slightly spread colour 
objects

l ~

Narrow/Choke 
White

Slightly spread colour 
objects AND contract 
areas of white toner

l l

Wide Expand colour objects 
more

l ~

Wide/Choke White
Expand colour objects 
AND contract areas of 
white toner

l l

Choke White Contract areas of 
white toner

~ l
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How to prepare and create 
labels

For printing black and white photos on dark media, simply open the 
image file in Photoshop and select Image > Adjustments > Invert. 
Then, save to PDF and print using the Prints Only Spot colour 
Toner setting.

while lighter elements will be printed with less. Meanwhile,
white or transparent elements, including image backgrounds, 
will be ignored completely.

If you’re working with mostly type and vector elements, open 
Illustrator or InDesign and create your layout using black 
to represent white. Because setting up files for Prints Only 
Spot colour Toner doesn’t require custom white 
swatches or channels to be defined (as you’ll see in later 
lessons where white and colour are used together), you 
can even use programs like Microsoft Word to create 
these all-white labels.

The image at left is the original file, while the image at right shows 
how the file will print using the Prints Only Spot colour Toner 
setting on black media.

Section 1:
Labels Using Only White 
Toner
The following sections explain how to prepare and create 
labels for white toner printing. For labels using white 
toner/varied white toner under colour toner we 
recommend using a vector based software application such 
as Adobe Illustrator or Corel Draw. This enables the most 
convenient and effective way of designing the labels.

If you’re planning to create a label that uses only white 
toner, you’ll be using the Driver Spot colour setting of 
Prints Only Spot colour Toner.

Prints Only Spot colour Toner is the simplest method 
of printing with white. Darker areas of your file, whether in 
grayscale or full colour, will be printed with more white 
toner, 
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Section 2:
Labels Using White Toner 
Under Colour Toner

Using Adobe Illustrator

One of the easiest ways to apply white behind colour as 
well as to standalone white elements is by setting up your 
file for the Spot colour setting of Data Portion - Including 
White. 
This setting doesn’t work with files created in Photoshop, so 
we’ll focus on Illustrator. Using the Data Portion - Including 
White setting automatically lays 100% white toner behind 
every element in your file (this is the data) - including the 
white swatch.

Note that the sample design shown doesn’t include any 
subtle white elements – white toner is always applied at 
100%, both under colour and for standalone white 
elements. Data Portion - Including White doesn’t allow for a 
percentage of white to be applied, so if your design requires 
total control of white, you’ll need to prepare your file for 
Application Specification which will be covered later in this 
guide.
>  Start to create a new label sized to your media.
>  Create a layer and fill i t w ith a  r ectangle approximating
 the colour of your intended media colour.
>  Name the layer “Media” and under the Layer Options, turn

Print off and Lock the layer. This avoids accidentally
printing the simulated media background layer – it won’t
even be exported to PDF.

>  Create a new layer named “Other Elements” and begin
creating your design using both coloured swatches 
as well as white. The Media layer allows you to see 
those white elements as they’ll appear on the printed 
page.>  Once your design is finished, export your file to PDF X-1a.

Print from Acrobat or Adobe Reader using the Data Portion 
- Including White Spot colour setting. Your printed 
results should look like your design, with white toner 
automatically laid down for standalone white elements as 
well as behind all colour elements.

This is all that’s required for simpler designs that combine 
both white and colour elements. If you need to achieve 
a greater level of control for determining where white is 
and isn’t placed on the printed page, you’ll need to move 
past Data Portion - Including White and onto the 
Application Specification Spot colour setting.

Setting up the simulated media background – turn off Print and 
Lock the layer.
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Section 3:
Labels Using Varied White 
Toner Under Colour Toner

Using Adobe Illustrator

So far you’ve learned that the easiest way to print with only 
white toner is to use the Prints Only Spot colour Toner 
Spot colour setting. And the simplest way to combine 
both white and colour is to use Data Portion - Including 
White.
But when your design calls for a subtle use of white – 
gradations, tints, etc. – or requires elements to print onto 
the media with a percentage of white with less than 100% 
behind them (often no white at all), you’ll need to use the 
Application Specification Spot colour setting to give you full 
control of where white does and does not go in your 
label.

The Application Specification setting works differently from 
Data Portion - Including White in that you won’t be using 
the white swatch. Instead, you’ll need to create a custom 
Spot colour swatch that will represent white.

Regardless of where white or coloured elements are 
placed within your file, white toner will only print where 
this custom white spot colour swatch is used.

>  To create the swatch, open your Swatches palette and
select a colour of your choice that you don’t plan to use 
in your label.

>  Double-click and rename the swatch SpotColor_White.
Then change the colour Type to Spot colour.

Create a spot colour swatch naming it as shown “SpotColor_
White“

>  Create the same Media layer as you did in the previous
lesson, filling the rectangle with the approximate colour 
of your intended media before opening the Layer 
Options panel and turning Print off and Lock on for the 
layer.

>  Then create a new layer, name it “coloured Elements”, and
begin laying out your design elements. Wherever you 
intend for a standalone white element (white without 
colour on top) to go, use the SpotColor_White 
swatch you’ve created.

For this layouts be sure to include coloured element 
that print directly on the media (the coloured texts

   surrouding pineapple  graphic), coloured elements that  
will have white printed behind them (the pineapple  
graphic and surrouding text), and standalone white  
elements (the white text, white line and white rectangle).

>  Once you’ve finished creating your design, you’ll need
to create a layer that contains spot colour white 
elements to print under your coloured elements.
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>  There are many ways to do this, but the simplest is to
Duplicate your coloured Elements layer and rename 
it “White Overprint”. 

>  Temporarily Turn Off the Visibility of your coloured
Elements layer to avoid confusion.

>  Then, working in the White Overprint layer, delete
everything except for the elements whose colour you 
want to preserve on dark media with white under printing. 
Once only those elements remain, change all fills and 
strokes to your SpotColor_White swatch.

>  Next, and most importantly, under Attributes, set
Overprint Fill and Overprint Stroke (when a stroke is used) 
to On for all of the elements on your White Overprint layer. 
This will prevent these white elements from knocking out 
the coloured elements below, instead allowing both 
white and colour to print.

Duplicate the coloured Elements layer and rename it White 
Elements. Then, delete all elements except those whose colors 
you want to preserve with white. Convert all remaining elements’ 
fills and strokes to the SpotColor_White swatch.

Turn on Overprint Fill and Overprint Stroke for all fills
and strokes in the White Overprint layer.

>  Turn your coloured Elements layer back On, export your file
to PDF X-1a.

>  Print from Acrobat or Adobe Reader using the Application  
Specification setting under Spot colour Usage Methods.

Your results should match your original design, with white 
toner replacing SpotColor_White swatch.

As you begin to further explore creating Illustrator files to 
be printed using the Application Specification Spot colour 
setting, you may want to turn on View > Overprint Preview 
within Illustrator to get a better idea of how your final 
design will print. This can also help troubleshoot errors 
before exporting and printing.

Make sure the “White Elements“ Layer is always on top of 
your Layers to print white properly.

Note: As the  Pro1050 always prints White underneath the 
colours it may help to change the SpotColor_White to C0, 
M0, Y0, K0 and put it underneath the “Coloured Elements“ 
Layer just for visualisation on screen. Don’t forget to move 
back the layer “White Elements“ to the top before exporting 
your PDF!

The sample file, printed with OKI Pro1050

Turn on “Overprint Preview” gives an accurate view of the file’s 
setup within the application before exporting and printing 
(“SpotColor_White“ swatch is set to green n this example)
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Section 4:
Labels With a Subtle 
Background Texture Using 
White Toner

Using Adobe Illustrator and 
Adobe Photoshop

This section will combine all techniques written above by 
incorporating both raster and vector elements into one 
file. This is necessary when you want your printed piece to 
include vector elements (like small shape and types) as well 
as subtle raster images like semi-transparent textures and 
photos. It make sense to work within a vector environment.

>  Begin by opening Illustrator and creating a layout of type
and vector elements based on the instructions in Section
3 on page 11.

Create a layout using coloured elements as well as SpotColor_
White elements

Set fills and strokes to the “SpotColor_White”

>  Create your SpotColor_White swatch and use it to
represent white, then create the White Overprint layer
and set fills and strokes to Overprint for the appropriate

 elements.

>  Next, open Photoshop and create a new label the
same size as your illustrator layout.

>  Create a new layer (Above the background layer) and
create a texture on this new layer.

Create your texture in Photoshop, on a new layer, above the 
background layer.

Create the New Spot Channel

>  Once your layers are set, make sure you have nothing
 selected.

>  Then load the texture layer’s selection by Control- or
Command-Clicking on the thumbnail of the layer.

>  Next, go into the Channels palette and create a New Spot
 Channel, naming it “SpotColor_White“
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>  To use only white in your texture, Turn Off the original
 texture layer after creating the Spot Alpha Channel. Or,
 leave the texture layer on if you’d like colour elements
 over white. You can even create new coloured layers to be
 printed directly onto the media for a more complex effect.

>  Now Turn Off the Background Layer and Save as a PSD
(Photoshop) file.

Create your texture, then create the SpotColor_White Spot Alpha 
Channel in Photohsop.

Create your texture, then create the SpotColor_White Spot Alpha 
Channel in Photoshop, turn off the background layer and save as a 
PSD (Photoshop) file.

within it will take on the same colour that you’ve defined
as your Spot Colour Swatch.

Place the texture PSD file into your original layout Illustrator 
file.

>  As you’ve done previously, export your file to PDF X-1a
(Read “Exporting to PDF“ on page 16)

>  Print from Acrobat or Adobe Reader using the “Application
Specification“ setting under Spot Colour Usage Methods.

Your final out put should be a seamless blend of the raster 
texture and vector elements.

The sample file, printed with OKI Pro1050

>  Go back to your original Illustrator label file and Create  
a New Layer named “Texture“. Under FIle > Place, browse  
to the Photoshop file containing your texture. Once this  
new file is in your Illustrator file, the Spot Alpha Channel
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Section 5:
Labels Using White Toner

Using Adobe InDesign

Adobe InDesign has many of the same capabilities as 
Illustrator when used to design labels that incorporate 
white printing elements. Using InDesign, it’s possible 
to create designs that print in only white (using Black 
to represent white and printing with the driver set to 
Prints Only Spot colour Toner) or incorporating 100% white 
behind colour elements as well as solid standalone white 
elements (using the Data Portion – Including White setting).

It’s also possible to create more custom pieces that 
incorporate OKI’s custom SpotColor_White swatch and 
using the Application Specification setting. 

However, working with InDesign for these types of pieces 
becomes a challenge when elements must be set with the 
overprint property. InDesign allows for native elements 
(text, lines, and shapes created natively in InDesign) to 
have their fills and strokes set to Overprint, but raster and 
vector elements created in Photoshop and Illustrator are 
automatically placed into frames, and neither these frames 
nor their contents are able to be set to overprint from within 
InDesign. 

The Overprint Fill and Overprint Stroke boxes will be greyed 
out for all placed graphic elements (the exception for this is 
frames filled with a solid colour). 

Because of this limitation, it is not recommended to use 
InDesign for complex files that require elements to be set to 
overprint (for example, the piece demonstrated in Lesson 3).

If you do choose to work with InDesign in setting up these 
kinds of files, you’ll need to create and/or modify any 
overprinted SpotColor_White elements within their native 
applications.

This means that each vector element placed within an 
InDesign layout that requires overprinting will need to be 
opened and modified in Illustrator (using the SpotColor_
White swatch), and each raster element that requires 
overprinting will need to be opened and modified in 
Photoshop (using the SpotColor_White Spot Alpha Channel).

Working this way can be time-consuming and tedious, which 
is why InDesign is only recommended as a design tool for 
the simpler types of labels incorporating white. For all 
other files, working in Illustrator is recommended.

Both Overprint Fill and Overprint Stroke are unavailable in InDesign 
for placed objects, which limits the ability to create complex files 
using white elements in the application.

NUTRITION FACTS
Serving Size 8 fl oz (240ml)
Servings Per Container 1

Amount Per Serving
Calories 110 Calories from Fat 0

% Daily Value
Total Fat 0g  0%
Sadium Omg   0%
Potassium 450mg  13%
Total Carbohydrate 26g  9%

Sugars 22g
Protein 2g
Vitamin C  120% Calcium  2%
Thiamin  10% Riboflavin  4%
Niacin  4%  Vitamin B6  6%
Folate  15%  Magnesium  6%

* Percent Daily Values are based on a 2,000
calorie diet. Your daily values may be higher
or lower depending on your calories needs.

Ingredients: 100% pure Florida
squeezed orange juice

NET WEIGHT 200 G.

BEST BEFORE: 29.02.2022
Pineapplejuice

Product of Singapore
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Exporting to PDF
Exporting labels from Adobe Illustrator, Photoshop, and 
InDesign to PDF and printing from Acrobat or Adobe Reader 
will streamline the printing process and reduce errors. And 
because Photoshop isn’t able to directly print files containing 
spot channels, exporting to PDF is necessary when designing 
your label in that application.

Additionally, files using the Spot colour setting of Application 
Specification require PDF type X-1a (either X-1a:2001 or 
X-1a:2003) for the named Spot colour to be transferred 
correctly from the source file to the PDF.

One helpful feature in Acrobat is the Output Preview mode 
under Print Production. This allows you Simulate Overprinting 
which is useful in making sure that Spot Colors are set up to 
overprint correctly. Acrobat Reader has a Simulate Overprint 
setting under Advanced Print Setup. 

Another benefit of Acrobat’s Output Preview is the ability to 
view the spot colour that you’ve defined in your file, which 
must be named SpotColor_White. Check under Separations to 
make sure this name is listed correctly.

You can also mouse over areas within your file to see where 
the Spot colour has been placed as well as the percentage 
used in each area.

Orange represents “SpotColor_White” in this file. Simulate 
Overprinting is turned off in the image at left and turned on in the 
image at right. The darker overlap of green and orange show where 
white will be printed under the graphics.
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Additional Tips

Once you’ve mastered the basics of preparing and 
printing files on the Pro1050, you’re more likely 
to encounter unexpected results. The information 
below will help prepare you for issues you may 
encounter as you create your spot colour files. 

Driver

>  The Application Specification option for Spot colour Usage
Methods is only available through the PostScript driver.
If you’re not seeing Application Specification as an option,
you likely have the PCL driver installed. Downloading and
installing the PostScript driver will fix this.

Selection (Illustrator)

>  Using the Selects Similar Objects tool in Illustrator is a big
time saver when changing white elements to the Spot 
colour swatch and separating them onto their own 
layer. If you’re having a hard time selecting one 
element of a grouped object, create a rectangle off the 
boundaries of your artboard, then use the eyedropper 
tool to match its colour to the object you want to select. 
With this object selected, use the Selects Similar 
Objects tool and make your modifications to the 
selected elements.

White Opacity
>  Try combining the media colour with toner colour to create

new colors by blending directly onto the media – for 
example, printing 100% Cyan (with no white behind it) 
onto red media creates a dark purple colour.

>  Darker colors (colors that contain a percentage of Black)
will print better if the black is removed and the percentage 
of behind them is lessened – for example, printing 0% C 
100% M 100% Y 25% K on black media with 100% white 
behind the element will look muddier than printing 0% C 
100% M100% Y 0% K (black removed) over 75% white –
this is an advanced technique the requires more effort, 
but can greatly improve results when printing white under 
colour on dark media.

Trapping

>  When printing designs that contain many small letters
or thin elements, it may be easier to use a manual 
trapping method for coloured elements printed over 
White rather than using the Driver’s methods. Try adding 
a .25 pt stroke of the same colour as the fill around your 
element and print with Trapping set to Off. This will 
preserve the fine lines that Choke White Trapping setting 
will lessen or eliminate.

Textures and Patterns

>  Adding a light pattern or texture that prints directly onto
the media can be a convincing effect – try a light texture 
the same colour as the media at a lighter opacity, and 
fade toward the edge of the printable page 
(approximately .2” from the page borders).

>  For advanced raster effects (especially subtle textures) in
Illustrator, create a texture with a transparent background 
in Photoshop, create the Spot Alpha Channel naming it 
appropriately, then import the PSD file into its own layer 
in Illustrator. The Spot colour will carry through.

>  Printing a flat image directly onto the media in a
percentage of white or the media colour will create a 
clear watermark effect.

Spot colour Swatch
>  Though the earlier instructions suggest creating the Spot

colour swatch in Illustrator after you’ve started 
working on your design, you can also do so 
immediately after you’ve created your label. This will 
save you from having to find and replace elements later.

>  When using Illustrator or InDesign, it is possible to create
a Spot colour swatch that’s actually white instead of 
using a colour like Magenta – this will be less 
distracting when designing the file, but it also makes it 
harder to tell if a PDF was set up correctly for Spot colour 
printing.

>  Overprinting the Spot colour swatch onto another Spot
colour (like a Pantone colour) in Illustrator or InDesign 
will not work. To fix this, select all Spot colour elements 
besides white and under Edit > Edit Colors and select 
Convert to CMYK.
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Spot colour Swatch (cont)

>  Though the Pro1050  typically places White under CMYK, the
instructions in Lesson 3 for the Application Specification 
Spot colour setting describe placing the White 
overprint layer on top of the colour layer – while this 
method may seem counter intuitive, it eliminates 
problems that come from compound elements (for 
example, a logo that contains blue text over a 
yellow oval) overprinting elements onto themselves – 
however, for simpler designs, placing the Spot colour 
white layer under the colour elements and having colour 
elements Overprint will also work.

>  When printing files that use the Application Specification
Spot colour setting directly from Illustrator, an 

additional setting must be set to ensure that elements 
using the  custom SpotColor_White swatch 
which require overprinting are rendered correctly. 
Under the Advanced tab, set the Overprints drop down to 
Simulate. (the White Overprint checkbox has no effect 
on the custom SpotColor_White swatch)

PNG Files with Transparent Backgrounds

>  Transparent backgrounds contained in PNG files are still
seen as Data when using the Data Portion - Including 
White Spot colour setting. Because of this, the 
entire image will print with white behind it. To correct 
this issue, Control or Command-Click on the 
thumbnail(s) of each layer, then create a Spot 
Alpha Channel (following the instructions in Lesson 5) 
and print using Application Specification Spot colour 
setting.

Media

>  Let the media breathe. Too much coverage – especially
around the edges of the printable area – can take away 
the benefit of printing on coloured media. The best 
results come from keeping elements toward the center 
of the page and allowing the media to show through 
as much as your design will allow.

Spot colour Toner Quantity Adjustment

>  With the Spot colour Setting “Data portion (Excluding
white)” and “Data Portion (Including White)” you may 
want to print 100% white behind all elements, including 

true black elements. To do so uncheck “Don’t layer white 
toner for 100% black” in the “Spot colour toner quantity 
adjustment”).

Finally, be aware that printing white and colour on dark 
media is both a creative and technical process. It’s rare 
that a piece comes out looking as the user expects the first 
time it’s printed. Experiment with driver settings, printer 
settings, various types of media, and file setup (especially 
opacity) to continue to understand the process and 
improve your results.
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OKI at a glance

OKI is a global business-to-business brand and pioneer of award-winning digital LED printer technology. Its 
compact, robust and leading-edge products combined with customer-centric solutions, empower businesses 
to create and print professional quality applications in-house. Used by organisations across a range of sectors 
including retail, graphic arts (print for profit), education, healthcare, hospitality & events, construction, 
engineering, chemical and more, OKI’s printers are renowned for their innovation, reliability, unrivalled media 
handling capabilities and superb colour quality.

Contact Us

Please do not hesistate to contact us for more information, label samples or to request product support and 
training, Please contact marketing@okieurope.com.




